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INTRODUCTION  
 

Welcome to the 'Michigan Environmental Mapper.'  The Michigan Department of 
Environmental Quality (DEQ) has provided this application to allow users to view, on a 
Michigan map, sites regulated under Part 201 Environmental Remediation1, Part 211 
Underground Storage Tanks, and Part 213 Leaking Underground Storage Tanks, of the 
Natural Resources and Environmental Protection Act, 1994 Public Act 451, as amended 
(Act 451). “   
 
The online interactive map viewer was created by the Remediation and Redevelopment 
Division (RRD).  Base map features and image backdrops are included as well as 
layers specific to this project.  With the viewer, users can locate storage tank systems 
on the map, find latitude and longitude coordinates, find addresses, and download 
spatial data. 
 
The Michigan Environmental Mapper home page is at (control/click) CLICK HERE and it 
provides the definitions, disclaimers, and associated links.  The application, itself, is at 
the web address:  http://www.mcgi.state.mi.us/EnvironmentalMapper/
 
 

CONTACT INFORMATION 
 

You may contact us as follows: 
 

• Call Nick Ekel, at 517-241-7036 or e-mail to ekeln1@michigan.gov, or 
 
• Call Susan Norton, at 517-373-2113 or e-mail to nortons1@michigan.gov. 
 
• Mail to:  Nick Ekel Jr., Geological Services Unit, Remediation and   
      Redevelopment Division, Michigan Department of Environmental Quality,   
      P.O. Box 30426, Lansing, MI 48909-7926. 

  
 

SYSTEM REQUIREMENTS 
 
In order to use Mapper, access to the Internet and version 6.0 or higher of Internet 
Explorer is required.  Web browsers, such as Mozilla Firefox, may be used also.  Some 
screens will have a different appearance depending on the web browser.   
 
Note:  Environmental Mapper uses “pop-ups”.  Make sure that they are enabled in the 
web browser when using the application. 
 
 
 
                                                 
1 The Part 201 layer is under construction and should be available in fall 2006. 
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SECTION 1: BASIC OUTLINE & PREVIEW DIAGRAM 
 
Environmental “Mapper” is an online application that has a variety of features to assist 
in planning and field operations.  Typical usage of Mapper will follow these 6 steps: 
 

Basic Outline 
 
1. Use search submenus or zoom tools to locate an area of interest. 
 
2. Select an Underground Storage Tank (UST) Site or Facility map layer(s) 

to view. 
 
3. Modify a background map with buttons if desired . 
 
4. Choose a tool to highlight items of interest. 
 
5. Select highlighted sites for additional details. 
 
6. Use links and tabs to export or print information. 

 
Most of these steps can be initiated from Mapper’s Main Page.  Figure 1-1 shows an 
aerial photograph highlighting two Part 213 sites that fall within a 2000 foot buffer 
placed around the southern shoreline of Crystal Lake, near Frankfurt. 

 
Figure 1-1: Mapper Preview 
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SECTION 2:  MAIN PAGE HIGHLIGHTS 
 
After entering the web address, the main page will be displayed (see Figure 2-1). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2-1: Main Page 
 

The main page has three primary areas of interest:  Links (bottom and top), Map 
(center area), and Side Menu (left area).  (*NOTE:  Section 3 explains Map Features 
and Section 4 describes the Side Menu.)  

 
Links 
 
There are numerous links located on both the top and bottom banners of the main page.  
Clicking on the top leads to the Environmental Mapper background information, DEQ, 
and State of Michigan home pages.  There are also links to this Help Guide, a Text-
Based Search, and a Contact Us link.  Along the bottom banner of the web page, there 
are additional links to a variety of other web sites (see Figure 2-2). 
 
 
 
 
 
 

Figure 2-2: Bottom Links 
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SECTION 3:  MAP EXTENT, TOOLS/BUTTONS AND TYPE 
 
There are three items associated with the central map area on the main page: 
 

• Map Extent - toggle the map size to the full extent of the browser window. 
 

• Map Tools/Buttons  - click these to zoom or recenter the map, measure 
distances, create a buffer zone, identify items, erase, or print the current map 
being displayed.  *NOTE:  Measure, Buffer, and Identify (House/Senate Detail) 
tools are explained further in Section 4 as they work in conjunction with the side 
menu. 

 
• Map Type - click these buttons to choose the map type being displayed.  Street, 

Aerial, Plat, Land Use, or Topographic maps are all available options.   
 
Map Extent  
 
The following buttons control the main map display in the center of the page: 
 

  This button is located above the map and to the right.  Clicking here 
allows the map to enlarge to the full extent of the browser window, as seen in Figure  
1-1. 
 

 This button replaces the Full Screen button after the map has been 
enlarged.  Clicking here returns the map to the default size, as seen in Figure 2-1.  
*NOTE:  When printing, be sure to have the screen size as the default view. 
 
Map Tools/Buttons  
 
The main map display can be modified in a variety of ways.  There are both tools (using 
the cursor to do a task) and buttons (alters map features or display immediately).  
These are contained in a tool bar located just above the main map (see Figure 3-1). 
   

 
Figure 3-1: Map Toolbar 

 
To make map tools/buttons active, click once with the mouse.  Click again to make the 
button/tool inactive or click on a different selection.  An active tool will be outlined with a 
red box and have its upper left corner filled in.    = Active Tool  = Inactive 
Tool 
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General Tools and Buttons: 
 

• Zoom in:  once active, click the cursor on the map to zoom in, or click and draw 
a box to show the zoom extent of the box and show a smaller area. 

 
Zoom Out:  click the cursor on the map area to zoom in and show a larger area.  

 
• Zoom to Previous Map or Back - click to view the previous map.  This tool will 

only go back one map and not to earlier ones.   
 

• Zoom to Last Extent or Forward - click here to zoom to the most recent map.  
This icon will turn red (as above) while viewing the previous map.   

 
• Recenter - once active, click on an area to make that the new center of the map. 

 
• Clear Screen - click here to erase any tool features currently active on the map, 

such as the Buffer seen in Figure 1-1. 
 

• Zoom Full - click here to return the map to the full extent of the state. 
 

Identify Single Location - once active, click near a site to show the facility’s 
Name, ID, and location; including street address, county, and district.  Clicking 
the Facility ID provides a link to additional information, see Figure 4-6. 

 
• Print - click here to print the current map - this will open up a new window 

displaying a print preview and printing options as an Adobe PDF file.   
*NOTE:  When printing, be sure to have the screen size as the default view. 
 

Tools with Submenus 
 
The Following tools work in conjunction with the Side Menu.  Each tool will open up a 
separate submenu to further define parameters used by the tool.  These tools are 
further explained in Sections 4, 5, and 6. 

 
• Measure - use multiple clicks to measure distances between two or more 

locations.  The measure submenu will automatically open. 
 

• Identify State House/Senate Detail - click to show House and Senate detail 
information about a location. 

 
• Select - drag a cursor extent window to select sites or facilities, and then retrieve 

statistics from the Environmental Mapper database. 
 

• Buffer Feature - highlight sites or facilities located within certain distances of a 
river, road, or other area of interest selected by the user.   
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• Buffer Polyline - highlight sites or facilities located within designated distances 
of a line, or multiple line segments created by the user.  

 
• Buffer Point - highlight sites or facilities located within designated distances or 

radius of a circle emanating from a point created by the user.        
 

Additional Items 
 
Tool Tips - When held over certain icons or listings, the cursor may change to a 
pointing hand and a tool tip will appear giving information about that item.  
 
Coordinates - To the right of the map tool bar are latitude and  
longitude coordinates indicating the location of the cursor on the map. 

 
Map Type 
 
Across the bottom of the map is a list of buttons that can change the background map 
being viewed in the main display area.  (*NOTE:  clicking on “Legend” in the Side 
menu will provide a map legend detailing items on the Street, Land Use, and 
Topographic Maps.  See Section 4 for more details.) 
 

 
Figure 3-2: Map Types 

 
The current map will have red text versus black.  The following selections are available: 
 

 Pressing this button (the default selection) allows the user to see 
roads, streets, and highways (Michigan Geographical Reference 
Version 5, soon to be Version 6). 

 
 Pressing this button allows the user to see aerial photos for the 

selected area.  Resolution can vary between counties.  (Maps 
Source: Rockford Map Publishers.  Black and White = 1992 United 
States Geological Survey (USGS) Digital Ortho Quarter Quad, and 
Circa 1998 USGS Digital Ortho Quarter Quad). 

  
 Pressing this button allows the user to see features ranging from 

individual parcel ownership to corporate city limits and others 
 (Rockford Plat Maps).  
 
 Pressing this button allows the user to see the various types of land 

cover, including types of vegetation, population density, and certain 
geology.  This map is based on the 2000 National Land Cover Data.  
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Pressing this button allows the user to see elevations of both man-
made and natural features, including lakes and streams off the USGS 
Topographical Quadrangles. 

 
SECTION 4:  SIDE MENU 

 
The left side of the main page is occupied by the “Side Menu.”  From this menu the 
following options and functions are available:  
 

• Legend - open a legend detailing the items displayed on the main map.  
• Layers - display Part 213, Part 201,2 and Part 211 sites on the main map. 
• Select - use with the Select tool to highlight sites of interest. 
• Buffer - use with the Buffer tool to highlight sites within given parameters,      
         Section 5. 
• Measure - choose a unit of measurement to use with Measure tool, Section 5. 
• State House/Senate Detail - find information with the Identify tool, Section 6. 
• Search - change the map display to match Address, Community, County, 

Legislative District, RRD District, or Watershed information entered by the user,  
         Section 7. 

  
Initially the Side Menu is contracted as seen in Section 2, Figure 2-1.   
 
To open up a submenu, click on the “ ”  
located to the right of the submenu title.    
 

 
 

 
The submenu will expand as seen in the  
Layers submenu open in Figure 2-3. 
 
To close a submenu, click on the “ ” and the  
submenu will contract. 
 

 
 
 
Above the side menu are two master controls.  
These control buttons will affect all submenus. 
 
 
 Figure 4-1: Expanded Submenu  
 

                                                 
2 Part 201 layer is under construction and will be available in fall 2006. 
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The side menu master controls are: 
 
Click here to open all submenus:   Click here to close all submenus.  

       
 
Note:  On the right side of the side menu is a scroll bar that also can be used to 
navigate through the open submenus. 
 
Legend 
 
Open this submenu to show a map legend corresponding to the main map display.  This 
is available for the Street, Land Use, and Topographic background maps and will 
automatically update when a new selection is made.  
 
*NOTE:  There is no legend information for either the Aerial or Plat Map backgrounds. 
 
Layers 

 
The second option in the Side Menu is the Layers Submenu.  This shows the available 
layers to choose to display on the main map:  Sites of Contamination (Part 213 and Part 
201) and Underground Storage Tank Systems (Part 211), see earlier Figure 4-1. 
 
When active, facility and sites will be represented on the main map by the designated 
symbols.  To make a layer active, simply click on the checkbox and a check will appear.  
To deselect a layer, click on the checkbox a second time.  
 
For a definition of the type of sites, leave the cursor on the item in the submenu and a 
Tool Tip explanation will appear.  
 
*NOTE:  Other functions will cause the layers to automatically become active.  
    
 
Select 
 
The select submenu works in conjunction with the Search Tool, , (see page 20).  
Activating the tool opens both the Select and Layers submenu, (a layer must be present 
in order to be selected.)  Once the Select Tool is active, drag a box extent to include the 
sites of interest.  In Figure 4-2, the user wishes to select Open 213 sites in the Petosky 
area.  
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     Figure 4-2: Select Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The items falling within the extent box 
will be highlighted in blue as shown in  
Figure 4-3. 
 
These sites are now selected.  For more  
information about them, click  
“View Selection” in the Selection 
submenu (see Figure 4-4). 
 
The site(s) information will appear in 
a new browser window (see Figure 4-5). 
 
 
 
 
 
 
 
 
 
 
 Figure 4-4: View Selection    Figure 4-3: Selected Sites 
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Figure 4-5: Selections Window 
 
This new window shows all the Storage Tank Facilities Data corresponding to the 
selected sites.  The information can also be exported to an Excel Spreadsheet by 
pressing on the designated button in the upper right. 
A facility may have more than one Leaking Under- 
ground Storage Tank (LUST) site name.  To list all the LUST site names under one 
facility, click on the 'Facility ID' number on the left in the table.  A new window will 
appear with more listings and details about the site selected. 
 
Clicking on the far right “  “ button will bring up a new window describing the 
Method of Collection at that particular site, as seen in Figure 4-6. 
 

Figure 4-6: Method of Collection  
 
 
 
SID Information 
 
Clicking on the Facility ID number next to a selection changes the window to show more 
specific information about that site (see Figure 4-7.)  This is a link to the DEQ’s Storage 
Tank Information Database or SID.  

 14



 
Figure 4-7: Specific Site Information 

 
*NOTE:  Other tools and submenus, such as Buffer or Search, also have the “View 
Selection” button available.  Each works in a similar fashion to the Select submenu.   
 
Use the browser 'back' buttons to return to the facilities list that were a part of the initial 
selection.  These browser windows may be closed without having to close the UST 
application. 

------------------- 
 
*NOTE:  Section 5 explains Measure and Buffer under Advanced Tools.  State House 
and Senate Details are explained in Section 6, while Section 7 describes the Search 
Submenu.  
 

SECTION 5: ADVANCED TOOLS - MEASURE & BUFFER  
 
MEASURE – This item measures distances between two or more locations or along a  
  selected path by using the following steps:   
 

1. Click the    button on the Map Toolbar to activate 
the tool.  The Measure submenu opens directly 
below the Buffer submenu (see Figure 5-1). 

 
    Figure 5-1:Measure Submenu 
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2. Select the unit of measurement to be used.  Click 
the      and choose meters, feet, or miles (see 
Figure 5-2). 
 

3. To begin measuring, click a location on the map  
to be used as the starting point.  
        

4. Move the cursor to your next location; this 
measuring leg is colored pink.  

 
5. Click on the new location to measure the 

distance; this completed leg becomes blue.                  
 

6. Continue the process until you arrive at your 
destination; click twice to finish measuring. 
          Figure 5-2: Measure Units 
 

*NOTE:  The measure of the current leg being drawn is listed as the Segment Length 
while the total distance is shown as Total Length.  In Figure 5-3, the measuring leg in 
pink is 1.01 miles and the total distance along the blue path is 6.02 miles.  
        

Figure 5-3: Measuring With Multiple Locations 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BUFFER – This item determines whether sites or facilities fall within a certain distance 

of a river or other selected location.  A buffer refers to an area of interest 
such as a zone of protection or potential area of contamination.  
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Buffer Tool Tutor 
To create a buffer, use the following steps: 
 
1.  Select the type of buffer tool:    
     Feature, Polyline, or Circle.  
   
*NOTE:  The Buffer Submenu will open 
     on the Side Menu (see Figure 5-4). 

 
2.  Units for Buffer - choose units to be 
     used for the buffer - Meters, Feet, or Miles.  
 
3.  Buffer Tolerance - choose the distance  
     the buffer will extend when using the buffer 
     tool (refer to step 6, to see how this 
     distance is used) .     Figure 5-4: Buffer Submenu   
 
4.  Choose the Sites - The Layer Submenu has also opened.  Click the desired layer 
     active if this has not already been done (see Figure 4-2, page 13).       
 
5.  Draw the Buffer - each buffer tool operates differently as follows: 
 

• Feature - use a polygon to select a buffer around an area of water (or other map 
feature when available.)  Drag the mouse to form a red rectangle over the 
desired area, then unclick.  A Buffer will extend a select distance from the midline 
of the river etc. to the next node along the river path outside of your selected 
area (see Buffer Tolerance regarding distance). 

 
*NOTE:  If Feature was chosen as the Buffer tool, that feature must be selected 
using the Select Buffer By (Feature) drop down menu.  Streams/Rivers/Lakes 
are currently available.  

 
• Polyline - click to begin building a line similar to the measure tool.  Double click 

to finish the line.  A buffer is created that extends the tolerance level outward 
from both sides of the line and its endpoints.  

 
• Circle - click the cursor to make the center point for a circular buffer.  The buffer 

tolerance is used as the circular buffer’s radius. 
 
After the parameters have all been determined, follow the procedure of the chosen 
Buffer tool (step 3) and click to place a point, click multiple times for a line, or drag a 
box over a desired feature to apply the buffer.   
 
Once these steps have been followed, the buffer is represented by a yellow polygon.   
Sites or facilities that have been chosen as the buffer layer will appear highlighted in 
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blue if they fall within the buffer’s area.  Click on the following links to find more 
information about these sites: 
 

– This button brings up a tabular listing of sites that fall inside the     
   buffer zone.  (NOTE: See Section 4 for further details) 

 
 Clear Screen – use this tool to erase the buffer.     
 
EXAMPLE:  Find Active Underground Storage Tank Systems (Part 211) within a 0.4 
mile radius of the US 131 and I 196 interchange near downtown Grand Rapids.  
 
First open the Search Submenu - type in Grand Rapids, select city as the option, then 
press “search.”  This will pull up the city of Lansing in the Main Page Display Map.  Use 
the zoom-in tool to get a closer view.  *Note: The Search Submenu will be explained 
further in Section 8.  
 
Next follow the buffer steps:  
 

1. Select Buffer tool - click      once to activate Buffer Circle. 
2. Select Units to Buffer - in the now open Buffer Submenu, use the down arrow 

and highlight “Miles.” 
3. Select Buffer Tolerance - type in “0.4”  
4. Select Layer to Buffer - click “Active UST Facility” checkbox in Layer Submenu. 
5. Click on the intersection of US 131, and I 196 to place the center of the buffer. 

 
This point becomes the center of the buffer (yellow circle), having a radius of 0.4 miles. 
All sites within the buffer are highlighted in light blue (see Figure 5-5).   
 

Figure 5-5:  Buffer Circle Example 
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SECTION 6:  STATE HOUSE/SENATE DETAIL 
 
Environmental Mapper has a tool allowing the user to view congressional information 
about an area.  This is the Identify tool, as mentioned previously in Section 4. 
 

• Identify State House/Senate Detail - click to show House and Senate detail 
information about a location. 

 
When the Identify tool is made active, the  
House/Senate Detail Submenu will open  
(see Figure 6-1). 
 
As the submenu explains, click the main map with 
the cursor to show Detail for the selected location. 
 
Once the Identify tool is clicked, the submenu      Figure 6-1: House/Senate Detail Submenu 
will change to show the following information: 
 

• COUNTY - clicked location is part of this county.  
• HOUSE REP - person listed is the House Representative for selected location. 
• REP PARTY - this is the House Representative’s party affiliation.  
• WEBSITE - click here to go to the House Representative’s website. 
• SENATE REP - person listed is the Senate Representative for the selected 

location. 
• SENATE PARTY:  this is the Senate Representative’s party affiliation. 
• WEBSITE:  click here to go to the Senate Representative’s website. 

 
Below is an example of the House/Senate Detail for Rogers City (Figure 6-2). 
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SECTION 7:  SEARCH 
 
Mapper has a variety of ways to search for a desired location.  The following options are 
available within the Search submenu (also see Figure 7-1): 
 

• By Address - enter a street address with 
either the City or Zip Code. 
 

• By Community - enter the community:   
     Village, Township, City etc.  

 
• By County - select a County from a list. 
 
• By RRD District - select a Remediation and  

Redevelopment Division District from a list.  
       
• By Watershed – select a Major Watershed     

Boundary from a list. 
         Figure 7-1: Search Submenu 

Eac S  the

   
• By Legislative District - select the House  
     or Senate District from a list. 

 
  and closing with the . h earch option may be opened by clicking on

 
Click on the down arrow,  next to an entry to show a list of choices, then click again ,
on in F
 

the desired district (highlighted blue) as seen igures 7-2 and 7-3. 

           
 
  Figure 7-2: Open RRD District  Figure 7-3: RDD District list of choices 
              Search Option.          by clicking down arrow . 
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 Once the appropriate information has been entered/selected, click on the 
button located toward the bottom of the section.  The main map display will change to 
match your search.  
 
Select Points by Location 
 
Several search options have the ability to use an Active Layer and map storage tank 
systems at the same time.  Above the Search button is a window with two circle 
checkboxes having the following options (see Figure 7-4):   
   

• Select Points - highlights sites from the active 
Layer when the map is displayed. 

 
• Do Not Select Points –only maps the intended 

ation or area without highlighting any points. 
nts  

• 

loc
            Figure 7-4: Select Poi

If you have no layers active and click the “ ” 
button, a warning message appears in a pop-up  

sites or facilities must 
s submenu as 

Mu l

window  as seen in Figure 7-5.  
 
 
NOTE:  The type of *

be selected from the Layer
escribed in Section 4. d

     
        Figure 7-5:Point Feature Message 
 
 
 

ltip e Results Found...      

 the c
sea h
(see F
 
Typ g e By 
Comm
urban, city, and township community type.  

se the scroll bar to navigate to the desired loca

tton.  
  
    Figure 7-6: 

 
In ase where multiple selections match the entered 

rc  criteria, a list of choices will be available   
igure 7-6). 

in  in “Lansing” for the Community Name in th
unity Search Submenu returns Lansing as an 

 
U tion. 
 
To map the location, click on the     bu

      

      Multiple Results 
       During Search    
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SECTION 8:  FREQUENTLY ASKED QUESTIONS (FAQs) 

) How do I see my storage tank sites?  
elect the type of sites to view. 

ore information about a particular site? 
Answer:  Use the Select Tool “        “ from the top Map Toolbar to highlight sites, 

nu (see pages 9, 12, and 13). 

p? 
Answer:  Use the bottom map type buttons and click  

). 

ed on “By Address.”  How do I 

move it up or down. 

5) How d
Answer:  Click on the full screen button 

 
 
1

Answer:  Click on Layers in the side menu, then s
 

2) How do I see m

then click on View Selection in the Select subme
 
 3) How do I see an aerial photo of my ma
 
 on the aerial button (see Map Type on page 10
 
4) I opened the submenu “Search,” and then click
    see the rest of the options? 
 Answer:  Use the scroll bar to the right of the menu and 
 

o I see a larger map? 
 just above the upper right 

corner of the map (see page 8). 

6) How
 nswer:  Click the Contact Us

 
 do I contact someone regarding Environmental Mapper? 

A  link just above the upper right corner of the map 
y also click on the 

 
 to send an e-mail to the appropriate personnel.  You ma

Environmental Mapper Home Page.   
 
)  How do I move my map over a little? 

en click close

) How do I clear my map? 

Answer:  Use the Identify Single Location tool Once active, click near 
 information (see page 9).  

 

7
Answer:  Use the Recenter tool “       ,“ th r to the desired location 
(see page 9). 

 
8
 Answer:  Use the Clear Screen tool “  “(see page 9).    
 
9) How do I see information about just one site? 

 “       .“  
a site to show the facility’s
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	In order to use Mapper, access to the Internet and version 6.0 or higher of Internet Explorer is required.  Web browsers, such as Mozilla Firefox, may be used also.  Some screens will have a different appearance depending on the web browser.  
	Note:  Environmental Mapper uses “pop-ups”.  Make sure that they are enabled in the web browser when using the application.
	SECTION 1: BASIC OUTLINE & PREVIEW DIAGRAM
	Environmental “Mapper” is an online application that has a variety of features to assist in planning and field operations.  Typical usage of Mapper will follow these 6 steps:
	Basic Outline
	1. Use search submenus or zoom tools to locate an area of interest.
	2. Select an Underground Storage Tank (UST) Site or Facility map layer(s) to view.
	3. Modify a background map with buttons if desired .
	4. Choose a tool to highlight items of interest.
	5. Select highlighted sites for additional details.
	6. Use links and tabs to export or print information.
	Most of these steps can be initiated from Mapper’s Main Page.  Figure 1-1 shows an aerial photograph highlighting two Part 213 sites that fall within a 2000 foot buffer placed around the southern shoreline of Crystal Lake, near Frankfurt.
	Figure 1-1: Mapper Preview
	SECTION 2:  MAIN PAGE HIGHLIGHTS
	After entering the web address, the main page will be displayed (see Figure 2-1).
	Figure 2-1: Main Page
	The main page has three primary areas of interest:  Links (bottom and top), Map (center area), and Side Menu (left area).  (*NOTE:  Section 3 explains Map Features and Section 4 describes the Side Menu.) 
	Links
	There are numerous links located on both the top and bottom banners of the main page.  Clicking on the top leads to the Environmental Mapper background information, DEQ, and State of Michigan home pages.  There are also links to this Help Guide, a Text-Based Search, and a Contact Us link.  Along the bottom banner of the web page, there are additional links to a variety of other web sites (see Figure 2-2).
	Figure 2-2: Bottom Links
	SECTION 3:  MAP EXTENT, TOOLS/BUTTONS AND TYPE
	There are three items associated with the central map area on the main page:
	 Map Extent - toggle the map size to the full extent of the browser window.
	 Map Tools/Buttons  - click these to zoom or recenter the map, measure
	distances, create a buffer zone, identify items, erase, or print the current map being displayed.  *NOTE:  Measure, Buffer, and Identify (House/Senate Detail) tools are explained further in Section 4 as they work in conjunction with the side menu.
	 Map Type - click these buttons to choose the map type being displayed.  Street, Aerial, Plat, Land Use, or Topographic maps are all available options.  
	Map Extent 
	The following buttons control the main map display in the center of the page:
	   This button is located above the map and to the right.  Clicking here allows the map to enlarge to the full extent of the browser window, as seen in Figure 
	1-1.
	  This button replaces the Full Screen button after the map has been enlarged.  Clicking here returns the map to the default size, as seen in Figure 2-1. 
	*NOTE:  When printing, be sure to have the screen size as the default view.
	Map Tools/Buttons 
	The main map display can be modified in a variety of ways.  There are both tools (using the cursor to do a task) and buttons (alters map features or display immediately).  These are contained in a tool bar located just above the main map (see Figure 3-1).
	Figure 3-1: Map Toolbar
	To make map tools/buttons active, click once with the mouse.  Click again to make the button/tool inactive or click on a different selection.  An active tool will be outlined with a red box and have its upper left corner filled in.    = Active Tool  = Inactive Tool
	General Tools and Buttons:
	Zoom in:  once active, click the cursor on the map to zoom in, or click and draw a box to show the zoom extent of the box and show a smaller area.
	Zoom to Previous Map or Back - click to view the previous map.  This tool will only go back one map and not to earlier ones.  
	Zoom to Last Extent or Forward - click here to zoom to the most recent map.  This icon will turn red (as above) while viewing the previous map.  
	Recenter - once active, click on an area to make that the new center of the map.
	Clear Screen - click here to erase any tool features currently active on the map, such as the Buffer seen in Figure 1-1.
	 Zoom Full - click here to return the map to the full extent of the state.
	Identify Single Location - once active, click near a site to show the facility’s Name, ID, and location; including street address, county, and district.  Clicking the Facility ID provides a link to additional information, see Figure 4-6.
	Print - click here to print the current map - this will open up a new window displaying a print preview and printing options as an Adobe PDF file.  
	*NOTE:  When printing, be sure to have the screen size as the default view.
	Tools with Submenus
	The Following tools work in conjunction with the Side Menu.  Each tool will open up a separate submenu to further define parameters used by the tool.  These tools are further explained in Sections 4, 5, and 6.
	Measure - use multiple clicks to measure distances between two or more locations.  The measure submenu will automatically open.
	 Identify State House/Senate Detail - click to show House and Senate detail information about a location.
	Select - drag a cursor extent window to select sites or facilities, and then retrieve statistics from the Environmental Mapper database.
	Buffer Feature - highlight sites or facilities located within certain distances of a river, road, or other area of interest selected by the user.  
	Buffer Polyline - highlight sites or facilities located within designated distances of a line, or multiple line segments created by the user. 
	Buffer Point - highlight sites or facilities located within designated distances or radius of a circle emanating from a point created by the user.       
	Additional Items
	Tool Tips - When held over certain icons or listings, the cursor may change to a pointing hand and a tool tip will appear giving information about that item. 
	Coordinates - To the right of the map tool bar are latitude and 
	longitude coordinates indicating the location of the cursor on the map.
	Map Type

	Across the bottom of the map is a list of buttons that can change the background map being viewed in the main display area.  (*NOTE:  clicking on “Legend” in the Side menu will provide a map legend detailing items on the Street, Land Use, and Topographic Maps.  See Section 4 for more details.)
	Figure 3-2: Map Types
	The current map will have red text versus black.  The following selections are available:
	 Pressing this button (the default selection) allows the user to see roads, streets, and highways (Michigan Geographical Reference Version 5, soon to be Version 6).
	 Pressing this button allows the user to see aerial photos for the selected area.  Resolution can vary between counties.  (Maps Source: Rockford Map Publishers.  Black and White = 1992 United States Geological Survey (USGS) Digital Ortho Quarter Quad, and Circa 1998 USGS Digital Ortho Quarter Quad).
	 Pressing this button allows the user to see features ranging from individual parcel ownership to corporate city limits and others
	 (Rockford Plat Maps). 
	 Pressing this button allows the user to see the various types of land cover, including types of vegetation, population density, and certain geology.  This map is based on the 2000 National Land Cover Data. 
	Pressing this button allows the user to see elevations of both man-made and natural features, including lakes and streams off the USGS Topographical Quadrangles.
	SECTION 4:  SIDE MENU
	The left side of the main page is occupied by the “Side Menu.”  From this menu the following options and functions are available: 
	 Legend - open a legend detailing the items displayed on the main map. 
	 Layers - display Part 213, Part 201,  and Part 211 sites on the main map.
	 Select - use with the Select tool to highlight sites of interest.
	 Buffer - use with the Buffer tool to highlight sites within given parameters,     
	         Section 5.
	 Measure - choose a unit of measurement to use with Measure tool, Section 5.
	 State House/Senate Detail - find information with the Identify tool, Section 6.
	 Search - change the map display to match Address, Community, County, Legislative District, RRD District, or Watershed information entered by the user, 
	Initially the Side Menu is contracted as seen in Section 2, Figure 2-1.  
	To open up a submenu, click on the “ ” 
	located to the right of the submenu title.   
	The submenu will expand as seen in the 
	Layers submenu open in Figure 2-3.
	To close a submenu, click on the “ ” and the 
	submenu will contract.
	Above the side menu are two master controls. 
	These control buttons will affect all submenus.
	 Figure 4-1: Expanded Submenu 
	The side menu master controls are:
	Click here to open all submenus:   Click here to close all submenus. 
	Note:  On the right side of the side menu is a scroll bar that also can be used to
	navigate through the open submenus.
	Legend
	Open this submenu to show a map legend corresponding to the main map display.  This is available for the Street, Land Use, and Topographic background maps and will automatically update when a new selection is made. 
	*NOTE:  There is no legend information for either the Aerial or Plat Map backgrounds.
	Layers
	The second option in the Side Menu is the Layers Submenu.  This shows the available layers to choose to display on the main map:  Sites of Contamination (Part 213 and Part 201) and Underground Storage Tank Systems (Part 211), see earlier Figure 4-1.
	When active, facility and sites will be represented on the main map by the designated symbols.  To make a layer active, simply click on the checkbox and a check will appear.  To deselect a layer, click on the checkbox a second time. 
	For a definition of the type of sites, leave the cursor on the item in the submenu and a Tool Tip explanation will appear. 
	*NOTE:  Other functions will cause the layers to automatically become active.     
	Select
	The select submenu works in conjunction with the Search Tool, , (see page 20).  Activating the tool opens both the Select and Layers submenu, (a layer must be present in order to be selected.)  Once the Select Tool is active, drag a box extent to include the sites of interest.  In Figure 4-2, the user wishes to select Open 213 sites in the Petosky area. 
	     Figure 4-2: Select Tool
	The items falling within the extent box
	will be highlighted in blue as shown in 
	Figure 4-3.
	These sites are now selected.  For more 
	information about them, click 
	“View Selection” in the Selection
	submenu (see Figure 4-4).
	The site(s) information will appear in
	a new browser window (see Figure 4-5).
	 Figure 4-4: View Selection    Figure 4-3: Selected Sites
	Figure 4-5: Selections Window
	This new window shows all the Storage Tank Facilities Data corresponding to the selected sites.  The information can also be exported to an Excel Spreadsheet by pressing on the designated button in the upper right.
	A facility may have more than one Leaking Under-
	ground Storage Tank (LUST) site name.  To list all the LUST site names under one facility, click on the 'Facility ID' number on the left in the table.  A new window will appear with more listings and details about the site selected.
	Clicking on the far right “   “ button will bring up a new window describing the Method of Collection at that particular site, as seen in Figure 4-6.
	Figure 4-6: Method of Collection 
	SID Information
	Clicking on the Facility ID number next to a selection changes the window to show more specific information about that site (see Figure 4-7.)  This is a link to the DEQ’s Storage Tank Information Database or SID. 
	Figure 4-7: Specific Site Information
	*NOTE:  Other tools and submenus, such as Buffer or Search, also have the “View Selection” button available.  Each works in a similar fashion to the Select submenu.  
	Use the browser 'back' buttons to return to the facilities list that were a part of the initial selection.  These browser windows may be closed without having to close the UST application.
	*NOTE:  Section 5 explains Measure and Buffer under Advanced Tools.  State House and Senate Details are explained in Section 6, while Section 7 describes the Search Submenu. 
	SECTION 5: ADVANCED TOOLS - MEASURE & BUFFER 
	MEASURE – This item measures distances between two or more locations or along a    selected path by using the following steps:  
	1. Click the    button on the Map Toolbar to activate the tool.  The Measure submenu opens directly below the Buffer submenu (see Figure 5-1).
	    Figure 5-1:Measure Submenu
	Select the unit of measurement to be used.  Click the      and choose meters, feet, or miles (see Figure 5-2).
	3. To begin measuring, click a location on the map 
	to be used as the starting point. 
	4. Move the cursor to your next location; this measuring leg is colored pink. 
	5. Click on the new location to measure the distance; this completed leg becomes blue.                 
	6. Continue the process until you arrive at your destination; click twice to finish measuring.
	          Figure 5-2: Measure Units
	*NOTE:  The measure of the current leg being drawn is listed as the Segment Length while the total distance is shown as Total Length.  In Figure 5-3, the measuring leg in pink is 1.01 miles and the total distance along the blue path is 6.02 miles. 
	       
	Figure 5-3: Measuring With Multiple Locations
	BUFFER – This item determines whether sites or facilities fall within a certain distance of a river or other selected location.  A buffer refers to an area of interest such as a zone of protection or potential area of contamination. 
	Buffer Tool Tutor
	To create a buffer, use the following steps:
	1.  Select the type of buffer tool:   
	     Feature, Polyline, or Circle. 
	*NOTE:  The Buffer Submenu will open
	     on the Side Menu (see Figure 5-4).
	2.  Units for Buffer - choose units to be
	     used for the buffer - Meters, Feet, or Miles. 
	3.  Buffer Tolerance - choose the distance 
	     the buffer will extend when using the buffer
	     tool (refer to step 6, to see how this
	     distance is used) .     Figure 5-4: Buffer Submenu  
	4.  Choose the Sites - The Layer Submenu has also opened.  Click the desired layer
	     active if this has not already been done (see Figure 4-2, page 13).      
	5.  Draw the Buffer - each buffer tool operates differently as follows:
	Feature - use a polygon to select a buffer around an area of water (or other map feature when available.)  Drag the mouse to form a red rectangle over the desired area, then unclick.  A Buffer will extend a select distance from the midline of the river etc. to the next node along the river path outside of your selected area (see Buffer Tolerance regarding distance).
	*NOTE:  If Feature was chosen as the Buffer tool, that feature must be selected using the Select Buffer By (Feature) drop down menu.  Streams/Rivers/Lakes are currently available. 
	Polyline - click to begin building a line similar to the measure tool.  Double click to finish the line.  A buffer is created that extends the tolerance level outward from both sides of the line and its endpoints. 
	Circle - click the cursor to make the center point for a circular buffer.  The buffer tolerance is used as the circular buffer’s radius.
	After the parameters have all been determined, follow the procedure of the chosen Buffer tool (step 3) and click to place a point, click multiple times for a line, or drag a box over a desired feature to apply the buffer.  
	Once these steps have been followed, the buffer is represented by a yellow polygon.   Sites or facilities that have been chosen as the buffer layer will appear highlighted in blue if they fall within the buffer’s area.  Click on the following links to find more information about these sites:
	– This button brings up a tabular listing of sites that fall inside the    
	   buffer zone.  (NOTE: See Section 4 for further details)
	 Clear Screen – use this tool to erase the buffer.    
	EXAMPLE:  Find Active Underground Storage Tank Systems (Part 211) within a 0.4 mile radius of the US 131 and I 196 interchange near downtown Grand Rapids. 
	First open the Search Submenu - type in Grand Rapids, select city as the option, then press “search.”  This will pull up the city of Lansing in the Main Page Display Map.  Use the zoom-in tool to get a closer view.  *Note: The Search Submenu will be explained further in Section 8. 
	Next follow the buffer steps: 
	1. Select Buffer tool - click      once to activate Buffer Circle.
	2. Select Units to Buffer - in the now open Buffer Submenu, use the down arrow and highlight “Miles.”
	3. Select Buffer Tolerance - type in “0.4” 
	4. Select Layer to Buffer - click “Active UST Facility” checkbox in Layer Submenu.
	5. Click on the intersection of US 131, and I 196 to place the center of the buffer.
	This point becomes the center of the buffer (yellow circle), having a radius of 0.4 miles. All sites within the buffer are highlighted in light blue (see Figure 5-5).  
	Figure 5-5:  Buffer Circle Example
	SECTION 6:  STATE HOUSE/SENATE DETAIL
	Environmental Mapper has a tool allowing the user to view congressional information about an area.  This is the Identify tool, as mentioned previously in Section 4.
	 Identify State House/Senate Detail - click to show House and Senate detail information about a location.
	When the Identify tool is made active, the 
	House/Senate Detail Submenu will open 
	(see Figure 6-1).
	As the submenu explains, click the main map with
	the cursor to show Detail for the selected location.
	Once the Identify tool is clicked, the submenu      Figure 6-1: House/Senate Detail Submenu
	will change to show the following information:
	 COUNTY - clicked location is part of this county. 
	 HOUSE REP - person listed is the House Representative for selected location.
	 REP PARTY - this is the House Representative’s party affiliation. 
	 WEBSITE - click here to go to the House Representative’s website.
	 SENATE REP - person listed is the Senate Representative for the selected location.
	 SENATE PARTY:  this is the Senate Representative’s party affiliation.
	 WEBSITE:  click here to go to the Senate Representative’s website.
	Below is an example of the House/Senate Detail for Rogers City (Figure 6-2).
	SECTION 7:  SEARCH
	Mapper has a variety of ways to search for a desired location.  The following options are available within the Search submenu (also see Figure 7-1):
	By Address - enter a street address with
	either the City or Zip Code.
	 By Community - enter the community:  
	     Village, Township, City etc. 
	 By County - select a County from a list.
	 By RRD District - select a Remediation and 
	Redevelopment Division District from a list. 
	 By Watershed – select a Major Watershed    
	Boundary from a list.
	            Figure 7-1: Search Submenu
	 By Legislative District - select the House 
	     or Senate District from a list.
	Each Search option may be opened by clicking on the   and closing with the  .
	Click on the down arrow,  , next to an entry to show a list of choices, then click again on the desired district (highlighted blue) as seen in Figures 7-2 and 7-3.
	  Figure 7-2: Open RRD District  Figure 7-3: RDD District list of choices
	              Search Option.          by clicking down arrow  .
	Once the appropriate information has been entered/selected, click on the   button located toward the bottom of the section.  The main map display will change to match your search. 
	Select Points by Location
	Several search options have the ability to use an Active Layer and map storage tank systems at the same time.  Above the Search button is a window with two circle checkboxes having the following options (see Figure 7-4):  
	  
	Select Points - highlights sites from the active
	Layer when the map is displayed.
	 Do Not Select Points –only maps the intended
	location or area without highlighting any points.
	            Figure 7-4: Select Points 
	 If you have no layers active and click the “ ”
	button, a warning message appears in a pop-up 
	window  as seen in Figure 7-5. 
	*NOTE:  The type of sites or facilities must
	be selected from the Layers submenu as
	described in Section 4.
	        Figure 7-5:Point Feature Message
	Multiple Results Found...     
	In the case where multiple selections match the entered
	search criteria, a list of choices will be available  
	(see Figure 7-6).
	Typing in “Lansing” for the Community Name in the By
	Community Search Submenu returns Lansing as an
	urban, city, and township community type. 
	Use the scroll bar to navigate to the desired location.
	To map the location, click on the     button. 
	    Figure 7-6:
	      Multiple Results
	        During Search  
	SECTION 8:  FREQUENTLY ASKED QUESTIONS (FAQs)
	1) How do I see my storage tank sites? 
	Answer:  Click on Layers in the side menu, then select the type of sites to view.
	2) How do I see more information about a particular site?
	Answer:  Use the Select Tool “        “ from the top Map Toolbar to highlight sites, then click on View Selection in the Select submenu (see pages 9, 12, and 13).
	 3) How do I see an aerial photo of my map?
	 Answer:  Use the bottom map type buttons and click 
	 on the aerial button (see Map Type on page 10).
	4) I opened the submenu “Search,” and then clicked on “By Address.”  How do I
	    see the rest of the options?
	 Answer:  Use the scroll bar to the right of the menu and move it up or down.
	5) How do I see a larger map?
	Answer:  Click on the full screen button   just above the upper right corner of the map (see page 8).
	6) How do I contact someone regarding Environmental Mapper?
	 Answer:  Click the Contact Us link just above the upper right corner of the map
	 to send an e-mail to the appropriate personnel.  You may also click on the  Environmental Mapper Home Page.  
	7)  How do I move my map over a little?
	Answer:  Use the Recenter tool “       ,“ then click closer to the desired location (see page 9).
	8) How do I clear my map?
	 Answer:  Use the Clear Screen tool “  “(see page 9).   
	9) How do I see information about just one site?
	Answer:  Use the Identify Single Location tool “       .“  Once active, click near a site to show the facility’s information (see page 9). 

